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Color Systems
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Color Systems
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Values for red, green, blue and alpha are floating point values 
with a range from 0 to 1 (ex. 0.3, 0.77)

Alpha component (a) defines transparency
Alpha of 1 is completely opaque, alpha of zero is completely transparent

Black RGBA is (0, 0, 0, 1)

Blue RGBA is (0, 0, 1, 1)

Gray RGBA is (0.5, 0.5, 0.5, 1)

Clear Completely transparent RGBA is (0, 0, 0, 0)

RGBA color



Daria Tsoupikova
Michael Papka
Hal Brynteson

Creative Coding
Fall/SpringCreative Coding— CS/DES 427/450/350 5

Black RGBA is (0, 0, 0, 1)

Blue RGBA is (0, 0, 1, 1)

Gray RGBA is (0.5, 0.5, 0.5, 1)

Clear Completely transparent. RGBA is (0, 0, 0, 0)

Magenta? Yellow? cyan?

RGBA color
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Unity color
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public class Ifstatement : MonoBehaviour { void Update() {

if (Input.GetKeyDown(KeyCode.C)) {

 GetComponent<Renderer> ().material.color = Color.cyan;

}

if (Input.GetKeyDown(KeyCode.M)) {

 GetComponent<Renderer>().material.color = Color.magenta;

}

if (Input.GetKeyDown(KeyCode.Y)) {

 GetComponent<Renderer>().material.color = Color.yellow;

}

}}

If statement
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public class Ifstatement : MonoBehaviour { void Update() {

if (Input.GetKeyDown(KeyCode.C)) {

 GetComponent<Renderer>().material.color=new Color(0.0f, 0.5f, 0.2f, 0.9f);

}

if (Input.GetKeyDown(KeyCode.M)) {

 GetComponent<Renderer>().material.color = Color.magenta;

}

if (Input.GetKeyDown(KeyCode.Y)) {

 GetComponent<Renderer>().material.color = Color.yellow;

}

}}

If statement
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The input manager allows to name an input 
and specify a key or button for it.

You can access keys on the keyboard and mouse buttons 
through scripting interface.

Edit > Project Settings >Input

Interaction - Key and Button input
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The input manager allows to name an input 
and specify a key or button for it.

You can access keys on the keyboard and mouse buttons 
through scripting interface.

Edit > Project Settings >Input

Interaction - Key and Button input
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Input.GetButtonDown("Fire1")) 
Mouse button left mouse 0

Input.GetButtonDown("Fire2")) 
Mouse button right  mouse 1

Input.GetKeyDown(”Jump")) 

space key space

Interaction - Key and Button input
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public class buttonInput : MonoBehaviour { void Update() {

if  (Input.GetButtonDown("Fire1"))

{

GetComponent<Renderer>().material.color=new Color(0.0f, 0.5f, 0.2f, 0.9f);

}

if  (Input.GetButtonDown("Fire2"))

{

GetComponent<Renderer>().material.color = Color.magenta;

}

if (Input.GetButtonDown(”Jump"))

{

GetComponent<Renderer>().material.color = Color.yellow;

}

}}

Button input interaction
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public class buttonInput : MonoBehaviour { void Update() {

if  (Input.GetButtonDown("Fire1"))

{

GetComponent<Renderer>().material.color=new Color(0.0f, 0.5f, 0.2f, 0.9f);

}

if  (Input.GetButtonDown("Fire2"))

{

GetComponent<Renderer>().material.color = Color.magenta;

}

if (Input.GetButtonDown(”Jump"))

{

GetComponent<Renderer>().material.color = Color.yellow;

}

}}

Unity documentation - KeyCode
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Create new object Sphere, add rigidbody component 

Create new Script KeyInput.cs

Assign script to the sphere

Interaction - Key and Button input
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void Update () {

if (Input.GetKey("up")) {

Debug.Log("up arrow key is held down");
}

if (Input.GetKey("down")) {

Debug.Log("down arrow key is held down");
}

if (Input.GetKeyDown(KeyCode.Space)) {

GetComponent<Rigidbody>().AddForce(transform.forward * 200f);
}

}}

Key input
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Uncheck Use Gravity in the inspector 

Test the scene

Interaction - Key and Button input
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Add useGravity to Rigidbody component in the script

GetComponent.<Rigidbody>().AddForce(transform.forward * 500f);

GetComponent.<Rigidbody>().useGravity = true;

}

Interaction - Key and Button input
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Assets are the models, textures, sounds and all other media files 

• Audio Files

• Materials

• Meshes

• Textures

• Prefabs

• Scripts

Project Organization
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RMC
Project>
Create Folder

Project Organization
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Assets > Folder >
Rename

Materials

Scripts

Scenes

Prefabs

Textures

Sounds

Project Organization
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Keep your assets organized

Be consistent with naming. If you decide to use camel case 
for directory names and low letters for assets, stick to that convention.

Use lowercase folder names

Use camelCase naming convention if needed

Sort all the assets in the corresponding folders

Project Organization
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Do not store any asset files in the root directory. 
Use subdirectories whenever possible.

Do not create any additional directories in the root directory, 
unless you really need to.

Use 3rd-Party to store assets imported from the Asset Store. 
They usually have their own structure that shouldn’t be altered.

Project Organization
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Audio
Music
SFX
Materials 
Models 
Plugins 
Prefabs

Project Organization

Resources 
Textures 
Sandbox 
Scenes
Levels
Scripts
Shaders
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Components are the nuts & bolts of objects and behaviors in a game.

A GameObject is a container for many different Components.

Unity Components
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Audio components 
Physics components 
The GameObject 
Image effect scripts 
Settings managers
Animation components 
Asset components

Unity Components

Mesh components 
Network group 
Particle components
Rendering components 
Transform component 
UnityGUI components
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Audio components Implement sound in Unity

- Audio Listener

Add this to a Camera to get 3D positional sound.

- Audio Source

Add this Component to a GameObject to make it play a sound

- Audio Effects

Unity Components
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The Game Object

GameObjects are containers for all other Components 

All objects in your scene are inherently GameObjects
a way to group objects

They are containers that hold Components, 
which implement actual functionality. 

Ex. a Light is a Component which is attached to a GameObject.

Unity Components
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Mesh components

3D Meshes are the main graphics primitive of Unity

Various components exist in Unity to render regular or skinned meshes,
trails or 3D lines

Mesh Filter 
Mesh Renderer
Skinned Mesh Renderer
Text Mesh

Unity Components
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Particle components

Particle Systems are used to make effects 

Smoke
Steam 
Fire
Atmospheric effects
Rain
Fog

Particle systems in Unity work by using one or two textures (2D), 
and drawing them many times, creating a chaotic random effect

Unity Components



Daria Tsoupikova
Michael Papka
Hal Brynteson

Creative Coding
Fall/SpringCreative Coding— CS/DES 427/450/350 30

Ellipsoid  
 spawns particles inside a sphere
Line Renderer
 draws a straight line between 2+ points in 3D space
Trail Renderer 
 makes trails behind moving objects in the scene
Mesh Particle Emitter 
 emits particles from the surface of the mesh
Particle Animator 
 Moves particles over time
Particle Renderer 
Particle Collider

Particle Components
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Open your Unity scene 
GameObject >Particle System

Rename it “Confetti”

Particle Components
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Open your Unity scene 
GameObject >Particle System

Rename it “Confetti”

Particle Components
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public class Confetti: MonoBehaviour {

public ParticleSystem confettiEmitter; 
void Start () {

}

void Update () {

if (Input.GetButtonDown("Fire1")) {
confettiEmitter.Emit(30);
  }
 }
}

Particle script
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Assign “ParticleScript” to a cylinder 
(drag and drop)

Assign Confetti Particles to
Confetti Emitter variable in the Inspector 
(drag and drop from Hierarchy)

Uncheck “Play on Awake” box in the Inspector 
Uncheck “Looping” box

With selected Confetti object in Hierarchy

Particle script
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Assign “ParticleScript” to a cylinder 
(drag and drop)

Assign Confetti Particles to
Confetti Emitter variable in the Inspector 
(drag and drop from Hierarchy)

Uncheck “Play on Awake” box in the Inspector 
Uncheck “Looping” box

With selected Confetti object in Hierarchy

Particle script
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Assign “ParticleScript” to a cylinder 
(drag and drop)

Assign Confetti Particles to
Confetti Emitter variable in the Inspector 
(drag and drop from Hierarchy)

Uncheck “Play on Awake” box in the Inspector 
Uncheck “Looping” box

With selected Confetti object in Hierarchy

Particle script
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Test the mouse button input and interaction

The particle should emit 30 particles on mouse click

Particle script
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Parent-Child Relationship in Unity

The Child Game Object will inherit the behavior of its parent 
It will move, rotate, scale exactly as its Parent does.

Similar to Arm/Body relationship- whenever your body moves, 
your arm moves along with it

This is a way of grouping objects together

Children can have their own children and etc.

Complex parent-child structure

Represented in the Hierarchy window

Parenting
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Add another if statement to add force to push cylinder forward:

public ParticleSystem confettiEmitter; 

void Update () {

if (Input.GetButtonDown("Fire1")) {
confettiEmitter.Emit(30);
  }
if (Input.GetKeyDown(KeyCode.Tab)) {
GetComponent<Rigidbody>().AddForce(transform.forward * 200f);
}
 }
}

Particle script
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Drag and drop Confetti particles inside the Cylinder object 
in the Hierarchy window

Test the game

Parenting
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Drag and drop Confetti particles inside the Cylinder object 
in the Hierarchy window

Test the game

Parenting
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Prefabs are prefabricated objects

Game Object > 3D > Sphere

Create Prefab “PrefabSphere” (drag and drop to project window)

Inspector : Add RigidBody Component

Delete Sphere in the Hierarchy window / scene

Prefabs



Daria Tsoupikova
Michael Papka
Hal Brynteson

Creative Coding
Fall/SpringCreative Coding— CS/DES 427/450/350 43

Prefabs
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Prefabs
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Instantiate is to create objects during run-time 
(as the game is being played)

Instantiate function takes three parameters;

• the object we want to create

• the 3D position of the object

• the rotation of the object

Instantiate
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1. Which object to instantiate?

the best way is to expose a variable

We can state which object to instantiate by using drag and drop 
to assign a game object to this variable prefab

2 Where to instantiate it?

create the new game object to locate new prefab 
whenever the Fire2 button is pressed.

Instantiate
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To clean generated prefabs from the scene, attach the following script 
“PrefabDestruction” to the prefabSphere

public class PrefabDestruction : MonoBehaviour {

void Start()

{

Destroy (gameObject, 5.5f);

}
}

Destroy script
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Create UsingInstantiate script and assign it to the cylinder:

public class UsingInstantiate : MonoBehaviour {
public Rigidbody spherePrefab; public Transform placetoStart;
void Update () {

if(Input.GetButtonDown("Fire2")) {

Rigidbody newInstance;
newInstance = Instantiate (spherePrefab, placetoStart.position, 
placetoStart.rotation);
newInstance.AddForce(placetoStart.forward * 50);
}
} }

Instantiate
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